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1 Preparing research posters

2

Grab attention

3

OGL v1.0: https://en.wikipedia.org/wiki/Road_signs_in_the_United_Kingdom

• Borders
• Big clear fonts, generous spacing
• Limited fonts / typefaces

- Bold black/dark text in white/light box
- Bold white/reverse/light text in dark box

• ALL CAPS USED sparingly for text hierarchy
• Sentence case without “.”  (Not Title Case)
• Clear, simple graphics

How to make & deliver effective research presentations

1 Preparing research posters

2

Limit poster fonts

4

Serif / San Serif
Serif / San serif

Times - Palatino Linotype - Georgia - Garamond
Bookman Old Style - Cambria    - Century

Arial - Montserrat - Cabin Medium - Trebuchet
• Arial Narrow    

• Tahoma
• Verdana   
• Calibri

Century Gothic - Corbel - Calibri Light - Montserrat Regular

100 pt

36 pt

24 pt
Comic sans
Impact

Lucida handwriting

French script
Monotype corsiva
Courier new

Title, bold
Subtitle

Heading

Body text

Footnote

18 pt

Serif reverse

San serif reverse

60 pt
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1 Preparing research posters
Poster messaging

5

CC BY: Jian Shang, Yushun Wan, Chuming Luo, 
Gang Ye, Qibin Geng, Ashley Auerbach, Fang Li. 
Cell entry mechanisms of SARS-CoV-2. Proceedings 
of the National Academy of Sciences May 2020, 117 
(21) 11727-11734; DOI: 10.1073/pnas.2003138117

Source: https://www.mhlw.go.jp/stf/covid-19/data.html

Headline

Key 
messages

Dark on light

Clear, simple 
figures

Acknowledgements

Call out / 
marker

Call to action: 
Further info

Purpose

1. Clear messages
2. Clear artwork

FIG 1. Good posters have clear 

messaging & effective layout

Headline

Key
messages

Dark on 
light

Clear 
figures

Call out

Intro  / 
Aim

Call to 
action

An example of a well-designed public service announcement poster from Japan, 

showing clear text and message hierarchy, simple and useful illustrations, and 

call to action via a QR code that provides further information. Note the parallel 

grammar (imperative structures) and limited colour scheme to allow highlighting of 

the most important parts. (Source: https://www.mhlw.go.jp/stf/covid-19/data.html)

Consistent 
colour

scheme

How to make & deliver effective research presentations

1 Preparing research posters
Portrait posters

6

Which is better?
A B

Source: https://depts.washington.edu/ddi/publications/GamesPoster.pdf

CC BY: 
https://figshare.com/articles/poster/A_review_of_how_Advanced_Biomechanics_and_Biotec

hnologies_can_be_successfully_used_to_inspire_and_motivate_students_/14370428

Light background

Readable 1 m away

Avoid 1 column

>1 column, L to R

Big bold headers

Left-aligned text

Bullet points

Too much text; 4 
columns crowded?

Photo size, 
position?

Graphs too small?

Conclusion too low

Divider line

Contact details

readingTinted background

Bordered boxes

Unreadable title, 
contact details?

Justified text

Too much text?

“White” space

2 columns

Text contrast/size?

Coloured title bar

Figures too small

References

Figures cramped

Conclusion eye-
level

Text on photo
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1 Preparing research posters
Landscape posters

7

A B C

CC BY: https://zenodo.org/record/5480014

Dark on light

Left aligned text

Key info higher up

White space

Bullet points

Acknowledge-
ments, Funding, 

Conflicts of 
Interest, Ethics?

Links; prefer QR

A0=118.9 x 84.1 cm
46.8 x 33.1 inches

4:3 or 16:9 (1280 x  
720 px) ratio

E-poster =
92.71 x 52.07 cm

36.5 x 20.5 inches

White on dark

Is this a good example? Short title, 
sentence case

3 columns

Flowchart & figure

Graphical 
abstract?

Help readers: 
• E-poster slides 

(paginate: x of 
5)

• Online poster:
- Enlarge parts 
of PDF on 
screen
- Make slides of 
enlarged parts 
of png / jpg 
image

Abbreviations

How to make & deliver effective research presentations

1 Preparing research posters
Colour schemes

8

Colour wheel

complementary

analogous

split 
complementary

triadic

Greyscale

Gradations

Single colour

Partial spectrum

Bipolar colour

Full spectrum

Qualitative 

Color-blind safe 
palettes: 

www.colorbrewer2.org
• Limit colours
• Use good colour scheme
• Repeat colour scheme for figures/tables

red

green

blue

orange

yellow

purple

White on light

Black on dark

http://www.colorbrewer2.org/
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1 Preparing research posters
Screen versus printing 1

9

CC BY (Nutthatida Phuangsaijai et al) https://www.researchgate.net/figure/Schematic-diagram-showing-the-difference-among-the-a-RGB-b-

CMYK-c-HSV-and-d-CIELAB_fig1_350737053

Cyan, Magenta, Yellow, Black
(subtractive mixing)

Red, Green, Blue
(additive mixing)

Printing (ink) Screen (light)

How to make & deliver effective research presentations

1 Preparing research posters
Screen versus printing 2

10

Add 3-5 mm for edges with colour “bleed” for print
PPT: Design > Slide Size > Custom 

Full screen

Crop mark

 printed as CMYK, 
300 dpi

72 ppi or 96 ppi, 
RGB for screen

Converted to 300 dpi, 
CMYK before printing

PPT handles only RGB, 220 ppi

PPT: File > Options > Advanced > Do not compress images 
https://slidelizard.com/en/blog/powerpoint-high-resolution-image-export

Acrobat Pro:  Tools > Print Production > Convert Colors 
(DeviceRGB FOGRA39 ISO12647-2-2004)

Printed

https://slidelizard.com/en/blog/powerpoint-high-resolution-image-export
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1 Preparing research posters
Layout principles

11

Balanced layout Unbalanced

Symmetrical Asymmetrical

Direction Scale

Pattern Contrast

A

Sentence-case conclusion style title
Name1 (professional email), Name2 & Name3

Institution

Context

Just use a few 
sentences for context 
here. Give the problem, 
research Q 
(+hypothesis), and aim.

Objectives:
• Use bullets here
• Try three bullets
• Use parallel 

grammar

• Main finding

• Theoretical & 
practical 
implications

• Limitations & 
future 
directions

References

1. Reference 1
2. Reference 2
3. Reference 3
4. Reference 4
5. Reference 5

Acknowledgements & 
Declarations

• Thanks go to…
• Funding: Grant 123, 

Agency Name
• Trial registration:
• Ethics board approval:
• Conflicts of interest:

Logo

Methods
• Use bullets here
• Try three bullets
• Use parallel 

grammar

Results
• Use bullets (Fig A)
• Don’t repeat Fig 

titles (Fig B)
• Unlike papers, add 

some explanation 
or interpretation 
(Fig C)

A

B

CD

E

Figure legends can go under 
each figure or summarised
underneath. Do not make them 
too small. Specify study 
conditions, replicates, 
statistical test & results.

Download 
poster

(CC BY) from 
Zenodo:

Conclusions

A

B

C

Rule of thirds

White on dark

Bordered boxes

White space

Bullets

Logical order

Flowchart

3 columns

Left aligned text

Large headings

Footnote at 
bottom

AR QR code

Conclusion 
box of 
“news” 

headlines

Refs & 
Acknowl-

edgements

Call to action:
QR to 

download; 
inc. © or CC 

notice

Large figures, 
clear labels & 

callouts

Detailed methods can go here 
in a footnote for those who are 
really interested. Consider 
providing a QR code linked to 
Protocols.io

Main finding of figure

Most important feature

Main finding of figure

Most important feature

Main finding of figure

Most important feature

Group A

Group B

Group C

Group B

Group A

How to make & deliver effective research presentations

1 Preparing research posters
Poster tips

12

1

Planning — check guidelines:
• Conditions, aims & scope; if must be 

unpublished
• Size, material, attachment, format, 

(file) requirements
• Deadlines; poster dates/times

Prioritising messages:
• Intro, Methods, Results, (min. Discussion), 

Conclusion
• Intro + Themes/Q&A + Conclusion
• Setting + Problem + Solution + Evaluation

2

Presentation:
• Standalone & fast reading
• Minimal text, simplify language

(but large text, use bullets)
• Large, high-quality graphics 

(get © permission if needed)
3

Preparation:
• Columns, fonts, colours, figures
• PPT alignment: Arrange > Align  / 

View > Ruler, Gridlines, Guides
• Project PPT on wall to test layout

4

Production:
• Print from PDF, CMYK 300 dpi; if screen, RGB 96 ppi
• Embed fonts; check if final format is Mac / PC
• Ask for colour proof/sample if print

5

Practice & performance:
• Practise with colleagues, inc.

meet & greet, Q&A
• Explain poster, don’t read  

point to figures, have 
conversation, ask for feedback

• More details on tablet computer; 
handout business cards & 
article/poster printout

6
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1 Preparing research posters

2 Preparing research slides

3 Tips for delivering presentations

How to make & deliver effective research presentations

2 Preparing research slides
Information style

14

Which is the best style for slides?

A B C
In this research project, we present the 

development and validation of the data 
produced by an up-to-date, scientist-friendly 

program for identifying jargon in popular written 
texts, based on a corpus of over 90 million words 
published in the BBC site during the years 2012–

2015. …[We test]… 5,000 pairs of published 
research abstracts and lay reader summaries 
describing the same article from the journals 

PLOS Computational Biology and PLOS 
Genetics…. As expected, more jargon was found 
in the academic abstracts than lay summaries; 
however, the percentage of jargon in the lay 

summaries exceeded the amount recommended 
for the public to understand the text. Thus, the 

De-jargonizer can help scientists identify 
problematic jargon when communicating science 

to non-experts, 

• Validate program for 
identifying jargon in 
popular written texts.

• Test 5,000 pairs of 
research abstracts and 
lay reader summaries. 

• More jargon was found 
in academic abstracts 
than lay summaries.

• Percentage of jargon in 
lay summaries exceeded 
amount recommended 
for public to understand 
the text. 

• De-jargonizer can help 
scientists identify 
problematic jargon when 
communicating science 
to non-experts.

Rakedzon T, Segev E, Chapnik N, Yosef R, Baram-Tsabari A (2017) Automatic jargon identifier for scientists engaging with the public and science 

communication educators. PLoS ONE 12(8): e0181742. https://doi.org/10.1371/journal.pone.0181742

• De-jargonizer
tested 5000 
abstracts vs lay 
summaries

• Jargon in abstracts > 
in lay summaries

• Jargon in lay 
summaries > 
amount public 
understands

• De-jargonizer
can identify 
problematic jargon
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2 Preparing research slides
Basic concepts 1

15

WIIFM ?

X TMI

TL ; DR

• Section names/Titles in “furniture”

• Maximum 8 bullets (maximum 2 levels)

• Text:

- Large, san serif

- Left aligned / right ragged

• Keywords only

• Parallel, reduced grammar

• “Animation” to control pace (Appear / Fade)

Good slide practices

Audience 
analysis:

- Context & 
background?

- Technicality?
- Detail?
- English level?
- Mode?

How to make & deliver effective research presentations

2 Preparing research slides
Basic concepts 2

16

• Put Section names/Titles in “furniture”.

• Maximum 8 bullets (maximum 2 levels);

• T e x t :

- L a r g e , s a n s e r i f

- L e f t a l i g n e d / r i g h t r a g g e d

• U s e k e y w o r d s o n l y .

• P a r a l l e l , r e d u c e d g r a m m a r ;

• “Animation” controls pace (Appear / Fade).

F E A TU R ES O F S L I DE TE XT

Don’t 
“Force justify”

Use parallel 
grammar, 

punctuation

Avoid 
ALL CAPS

Avoid 
too many 
emphases

B I U
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2 Preparing research slides
Slide readability

17

San Serif
San serif

Arial - Montserrat - Cabin Medium - Trebuchet
• Arial Narrow    

• Tahoma
• Verdana   
• Calibri

Century Gothic - Corbel - Calibri Light - Montserrat Regular

30 pt

22 pt

Title, bold
Subtitle

Heading

Body text

Footnote

18 pt

San serif reverse

San serif reverse40 pt

50 pt

PPT: File > Options > Save > Preserve fidelity when sharing this presentation > Embed fonts in the file

How to make & deliver effective research presentations

2 Preparing research slides
Basic concepts 3

18

Vary slide style to tell story
1-2 minutes per slide, without “Transition” 
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2 Preparing research slides
Basic structure

19

1. Title slide

2. Optional slides:

- Agenda?

- Bio slide?

- Conflicts of interest?

3. Main slides (+ Summary slide?)

4. Refs/Acknowledgements

5. Thank you & Any questions (+ Professional contact details)

Typical conference slides

How to make & deliver effective research presentations

2 Preparing research slides
Align aim with claims

20

CLAIMS

1. Introduction

2. Methods

3. Results

4. Discussion & Conclusion

1. Main Q [from problem 
statement]?

2. Research Q1?

3. Research Q2?

4. Research Q3?

5. Proposed model [solution]

Finding 1, F2, F3 
 Conclusion

Objective 1
O2
O3

Research Q 1 (H1)
RQ2 (H2)
RQ3 (H3)

Main Q 
 Aim

Solution

ProblemMotivation, 
Study Aim 

& Approach

Study Claims

Agenda
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Illustration style

21

CC BY: Jian Shang, Yushun Wan, Chuming Luo, Gang Ye, Qibin Geng, Ashley Auerbach, 
Fang Li. Cell entry mechanisms of SARS-CoV-2. Proceedings of the National Academy of 
Sciences May 2020, 117 (21) 11727-11734; DOI: 10.1073/pnas.2003138117

Don’t use article figures

How to make & deliver effective research presentations

Slide tips

22

1

Planning — check guidelines:
• Conditions, aims & scope; if must be 

unpublished
• (File) requirements, slide ratio, 

upload
• Deadlines; talk date/time/length

Prioritising messages:
• Outline (storyboard, sketch): Key message/s
• Clear structure: Intro, Methods, Results, 

Discussion, Conclusion
• Full script  notes  min. notes  key words

2

Presentation:
• Bullets: only 2 levels, key words
• Clear, appropriate graphics 

(with © permission)
• Variety of slides3

Preparation:
• White background, 96 ppi, RGB
• Animation/ordering
• File format, backups, test Mac / PC4

Pre-test equipment:
• Laptop, A-V connections, mic, laser pointer, staging
• Online conference: webcam, WiFi (cable), headset 
• Online platform: test slides, mute/unmute, Q box?

5

Practice & performance:
• Practise with colleagues, inc.

timing, body language, Q&A
• Smile, eye contact, clear voice; 

don’t read, don’t memorise
(except for start & end)

• Extra slides of results

6

2 Preparing research slides
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1 Preparing research posters

3 Tips for delivering presentations

2 Preparing research slides

How to make & deliver effective research presentations

Attending conferences

24

3 Tips for delivering presentations

www.ThinkCheckAttend.org

Beware of predatory 

CON-ferences

Present,
Answer Qs

Constructive 
feedback

Share,
Learn

Network

Gain
expertise

Attract 
attention

http://www.thinkcheckattend.org/
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Conference conversations

25

3 Tips for delivering presentations

Context

Contact Content

Clear concept
Plan sequence/structure; tell research & human story, set the scene 

(Why, When, Where, Who, How?)

Confident 
communication
Convey findings of your 
work & their value, 
implications
(What, So What?)

Collaborative 
connections

Make your case, 
invite feedback
 Call to action 

(Now what?)

Awareness
Interest
Decision
Action

Correct
Logical
Attention-getting
Interesting
Memorable
Supported

Catalysts

How to make & deliver effective research presentations

Live presentation

26

3 Tips for delivering presentations

Poster sessions Oral presentations Virtual conferences
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Presentation purposes

27

3 Tips for delivering presentations

Poster sessions

Oral presentations

???… ... …

How to make & deliver effective research presentations

Effective communication

28

3 Tips for delivering presentations

Ethical

Engaging Evidence

Credibility
• Elevator pitch (Who you are; whom & how you help)

• Your credentials, experience, reputation
• Enthusiasm, professionalism, cite credible sources, no exaggeration

Logic, reasoning
• Data, facts
• Convincing argument, 

explanation, structure
• Joined-up thinking, trust 

& transparency

Empathy
• Human interest, values, 

inspiration, insight
• Audience level/state 

define jargon, clarify, 
simplify, add examples?

• Story telling:
- Frontloading/context
- Rule of thirds
- Analogy
- Involvement, eg, ask 

real/rhetorical Qs

Style & delivery
• Effective visual aids
• Elocution, eloquence
• Expressiveness, 

expression
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Presentation language

29

3 Tips for delivering presentations

Semi-formal, clear, concise, conversational

X The approach that was adopted in this study was as follows... What we did was to…
X Addition of the catalyst led to a 100% increase in efficiency (Fig 1)  Here, you can see the rate doubled…
X There will now be an opportunity to ask questions  I’m happy to answer any questions you may have...
X The screen’s all out of whack  The screen’s not working

Tell a story

X The aim of our study was to... The public really needs our help to learn to verify science news.

X Introduction-Methods-Results-Discussion-Conclusion Teaser/synopsis – Orientation – Complication –
Climax – Resolution – Coda  

Q&A

[Can’t hear Q]

[Complicated/unclear Q]

[Not a Q, but a criticism]

 Could you repeat that please? …  So, the question is: …

 Thank you. So, I think your question is about… Can I get back to you by email?

 Thank you. I think you’re referring to… We actually checked for that…

How to make & deliver effective research presentations

Presentation tips

30

3 Tips for delivering presentations

1

Planning:
• Create compelling content: structure  

story  speech  notes  visuals
• Allow time; proofread, check 

symbols, fonts, colours
• Time/record self-practice 

fluency, smooth transitions

Practice with (non-)colleagues:
• Use paralanguage, intonation, pausing, gestures
• Pronounce well (eg, Verb/Noun: Increase, Project, Record )
• Build rapport, use feedback

2
Preparation:
• Dress smartly, arrive early
• Take deep breaths, sip water,

smile in mirror, warm up voice
• Online: reboot, turn off alerts, 

join early, test file & any video
3

Performance:
• Smile, face audience, keep posture
• Keep calm, have conversation
• Adjust pace, messaging, energy

4Post-mortem:
• What worked well, not so well
• File corrections
• Make contact: answer Qs; follow 

(up) collaborators, editors, lab 
heads 

6

Public relations (Q/A):
• Understand their point; get to your point
• Provide backing; offer to contact later
• Keep diplomacy, polite; no personal attacks

5
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1 Preparing research posters

2 Preparing research slides

3 Tips for delivering presentations

resources@asiaedit.com

Thank you!

© AsiaEdit 2021
CC BY-NC-ND except where noted

www.asiaedit.com

http://www.asiaedit.com

